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CAD Portion of the Program 
 

Linetype Manager 

 

The biggest change in CimCAD is the new linetype manager. The initial dialog looks similar. 

 

 
 

However, for example you can now access the flags for the linetypes right from this dialog. 

 

 
 

More importantly, if you go to Add Line, you can add a linetype to that section of the linetypes. 



 
 

Each range of linetypes now has a user section at the end, so that users can now add linetypes to each 

category without worrying about causing conflicts between the linetypes we typically add. 

 

Database & Forms 

 

Improved 'find data source' interface - When the user does a search in data sources, make it look for 

partial matches, etc., rather than insisting on a complete match to the internal name 

 

Added auto-wrap text option to Forms interface 

 

Improve SQL Server to include database selection within the setup interface (previously you had to 

ensure that the database connection defaulted to using the database you wished for Cimex, now you can 

explicitly specify which one to use) 

 

Database - search in database remembers your last search criteria even when that criteria included non-

local characters 

 

Improved handling of custom database macros and how they interact with the new SQL server support 

Data source manager interface improved 

 

Speed Enhancements 

 

Continuing again on the trend of the last several versions, we added some more engine improvements to 

speed up some common actions and to streamline various tasks, improving the general speed and 

responsiveness of the software.  

 

Improved memory management & reporting facilities so that CimPACK uses the least memory necessary 

(which improves speed) 

 



Open Preview 

 

Many enhancements were made to Open Preview such as the ability to sort your files by various criteria, 

faster viewing of your files (if you revisit the same folders repeatedly), and added date-time to labels 

(consistent with old preview), and more... 

 

Keeping cached preview files – This new feature keeps track of whether a preview cache is accurate or 

not, in addition to the cache itself.  This way it doesn't get deleted between visits (and consequently is 

only update as needed), so makes a big speed difference depending on the size of the folder. 

 

Next Job 

 

A new File > Next Job option was added which utilizes an automatic numbering system to get and use the 

next job number that is available. Various configurations allow you to tailor the method used to generate 

the job number / filename. 

 

 
 

Miscellaneous 

 

The File Menu now has separate Open and Import commands, and your preference is mapped to Ctrl+O 

and Ctrl+I respectively, and the alternates are mapped to Ctrl+Alt+O and Ctrl+Alt+I so both methods are 

now available with hotkeys. 



 

Sections Dialog - allows multiple selections for all actions 

 

Added a history to Tools > Fill, so remembers prior actions 

 

Implemented an auto-size text option which automatically sizes a text's font so that it fits within a given 

rectangle 

 

Added indicator on title-bar to show if your design needs to be saved (has been modified) 

 

Info menu - various improvements were made to the handling of tooltips and the information displayed 

 

Preferences - automatically saves a backup copy of your main configuration file Config.ini if you make 

changes (first time each day) 

 

When viewing by Pointage, fill colors are now also based on pointage so more consistent 

 

Undo now tracks the past 20 actions (used to be limited to 8), so much more powerful 

 

UNC - fixed issue with very large arcs and bridging 

 

Export DXF/DWG - more options as to how to map the exported lines 

 

Additional hotlighting added to main menu & control over all hotlighting added to Advanced View 

options 

 

Added configuration option to allow *.* as your default file filter for open / import 

 

Improved DDES3 export of annotation text and dimension entities 

 

Improved handling of locked files when you have a network problem, or where you left a file opened & 

locked and let your PC fall asleep 

 

Cimex Plot Spooler – Various DXF based spooler prototypes / outputs were added such as for the 

Kongsberg  (with its own tweak macro & map folder), a Generic DXF option, and the DXF-AAMA 

(Aeronaut). 

 

Info - Right click now copies the information directly to the clipboard (whatever text would have been 

created by left click) 



CimPACK Portion of the Program 

 

Rotary 
 

The Routing Option in the rotary menu now has a Quickmill option to support the available 6 tool routing  

options on the lasers. This has settings and depths for the various tools, and also options on output 

for automatic chamfering of handle edges and shell edges, and back routing of ejector cavities. Various 

changes were made in rotary to make this possible. Whether the bolts are to be done with a single plunge 

or a routed profile is also set here, and options for the type of milling to be done for the bolt whether 

it has lead-ins etc. All this is tied into the new laser drivers for Elcede and Lasercomb. 

 

 
 

The default X,Y size for Rotary Ejector Cavities can now be configured using parameters, and an 

additional quick button for setting the width to 11/16 was added. 

 

The fixed clamp locations for Elcede / Lasercomb are now available in the rotary boltholes menu, and 

when added you get the option to check distances and move the collars if necessary. If you do move 

the collars to reduce interference with the design, dimensions are added to show how far the job needs 

to be shifted over at the laser. Due to the routing capabilities of the new lasers, much more care needs to 

be taken to make sure the screw locations are specified here in the CAD, and the locations clearly marked 

and transferred to the laser operator so screws don’t get hit by the router by mistake. There are various 

options for adding in the screw locations, and passing on that information for correctly and safely 

mounting on the machine. Each collar is numbered, and the screws that are going to get used are marked 

and dimensioned automatically.  



A first version of a milling interference check was added for the Elcede / Lasercomb rotary lasers, 

checking to see if any routed lines are found within the fixed collar areas. The problem areas are 

highlighted, but the output is not prevented. The pointage to output the boltholes to is now changeable 

in the Quickmill dialog. When outputting routed lines, you now get the option of filling the lines as 

in the Gerber output. 

 

Improvements were made to the routing options on the laser outputs for filling routed shapes. There 

is now an option to clear the current router settings, so default settings can be re-loaded. 

 

The Rotary Clear Cylinder option now special cases the Y Stretch variable, so if you have a design 

stretch and then clear all the cylinder information, the stretch amount is still retained for the new cylinder. 

 

Two additional rotary shell dovetail options were added. 

 

The Rotary Shells Menu now allows the rule height to be changed, so if adding shells with non standard 

rule heights initially, more accurate sizes can be controlled. 

 

The configuration for the number of rotary shell widths used has been expanded from 10 to 15 shells. 

Also,  for fixed collar lasers, the collar number that is to be used to start mounting the shell at is 

configurable next to each of the shell sizes. The fixed clamp locations for the RotaMate / RotaMate evo / 

ProRot3000 are now all supported. 

 

The rotary boltholes menu now has an option to designate some bolts as an alternative size, so multiple 

washer sizes can be used in the same job. The laser outputs for milling were changed to also route the 

different sizes. 

 

The Ward Pin Stripper software now supports retainers of 1 and 1.5mm as well as 2/3/4. 

 

An additional rotary bolt slot shape was added. 

 

Rotary shells now have a configuration to automatically add chamfers at seam edges. 

 

The routing bleed around the rotary evol lifters was increased slightly for more clearance, and a parameter 

was added to disable the beam compensation when adding the lifters to the manufacturing jig. The finger 

profiles were also adjusted. 

 

The Mitsubishi lifters now add a text string designating the current lifter number, which then carries  

over to the lifter jig. This now makes it easier to figure out which lifter goes where for more 

complicated jobs. 

 

The Mitsubishi Evol menu now has an option to change the physical lifter profiles to and from 

construction lines with a single click. 

 

The current Mitsubishi Evol Lifter Jig supports 15 of each type (left / right / center), a larger version 

that supports 24 of each lifter type was created, either can be used. 

 



 
The Pace Mitsubishi Evol Lifters option was updated to include some new profiles. 

 

When adding auto perf on the Evol pins, you can now add the perf at any angle, not just 0 and 90. 

 

A configuration was added for the size of the Martin / Bobst Posilock V-notches on the back of the shell. 

 

For both Posilock and Serrapid patterns, changes were made to the boltholes to re-scale them after the 

cylinder scaling , as otherwise can route slightly the wrong size. 

 

Adjustments were made to the SR3/SR4 mushroom openings for the 66 inch machines. All 6 of the 

current SR4 Serrapid Cylinders were changed to use the new method of using a 20 degree taper on the 

slots for the pins on the edges of the shells. 

 

Tackbridges were added to the openings in the rotary Hamada lifters. When creating a rotary Hamada 

stripping board, you now get an option to control the scaling done from the die to the stripper. 

 

 



 

Similarly, there is also now an option to have the pins shift either to the trail or to the lead, so adjustments 

for pin wear can be made. 

 

 
 

Additional rotary cylinders were added as follows – 

 Serrapid SR3 Ward 66 (offset scribe twist 180 version)’ 

 Serrapid SR3 Apstar 16/32 

Serrapid SR4 Martin DRO 1628 

Serrapid SR4 Ward 37.5 

Serrapid SR4 Ward 66 (an offset seam variation) 

Serrapid SR4 Sun 66 (bolt between) 

S&S 38 (with 20 rows around not 18) 

Chieftain Giant 36 

Bobst / Martin Posilock 8.20 (bolt on center) 

Bobst / Martin Posilock 1232 (bolt on center) 

 

New Licensed Driver Modules 
 

New licensed driver modules were added for Elcede and Lasercomb lasers to go along with the existing 

Gerber one. The Elcede driver still has an independent configuration, however the new Lasercomb one 

goes through the same standard / generic laser driver that the Gerber one does. As this creates more 

situations when people have multiple lasers, both sets of laser drivers now have 4 configurations each. 

Also, a configuration was added to pick from the different types of lasers and models to facilitate setting 

them up. Both the Elcede and Lasercomb drivers support a 6 tool changer for routing. For example, the 

old drivers would only work in metric, now the lasers can be run in either metric or imperial, and either 

pointage based or slot width (pwidth) based. 

 

Furthermore, new driver modules were created for both Elcede and Lasercomb counter cutters, and are 

fully configurable as the new laser drivers are.  

 

Contact us for more information about these new options. 

 

Stripping Boards 

 

Male Stripping Boards now has an option to bring in the profile of the female stripping board, and make 

those lines etched. Also, the pin/tab combination file now has a separate file for the outside areas, so 

different configurations can be used on the inside versus the outside stripping. 



When pulling in claws and pins from the female stripping board, the male stripping board can also pull in 

nested pin setter pins inside the tab and pin combo files. 

 

The Copy / Move menu option was added to the sketch menu, so when adding vacuum holes in a 

stripping board block, they can be copied and moved easily. 

 

When creating Guillotines with Easyset holes, all the holes that are inside the guillotine / waste 

separator are now automatically turned on for you. 

 

Configurations were added to stripping boards to allow both internal and external wooden blocks 

to receive sequential numbers on them. Also, you can now use the spacer-bar to rotate the names 90 

degrees at a time when positioning them. 

 

The use of undo was improved when adding tabs with claw / pin combinations. 

 

Separate support was added for the Young Shin 2100S and Giant 2100SII machines. Options for the 50x6 

centerline notches were added to both male and female stripping boards. Also, the suspension holes are 

now available for the 2100 in the male stripper. 

 

Ejection Rubber 
 

Ejection Rubber now has a secondary width which is used for outside pieces, so they can now be different 

than the width of the inside pieces. Similarly, the Ejection Rubber Panels option now has widths for all 

three rubber types used so can be varied. Also, there are now options to load and save all the dialog 

settings in the dialog to and from files, so you can configure different settings per customer or type of 

work etc. 

 

 



 

An initial version of Find Panels was added for label / gasket dies, so works on designs that have no 

creases / folds on them. A corresponding new shape was added to the second page of shapes, and 

improvements made to other shapes to facilitate this. The current default rubber type and settings is used 

for the full design. It is for dealing with shapes that have multiple closed shapes of cut lines separated 

from each other, and can have another closed shape around them, so nested to a second level. Here is an 

example of a simple gasket. 

 
And here is an example of part of a label die run through the new option. 

 
 

Ejection rubber now has a third category after panels and windows called scrap. It is basically a different 



version of the window option, however for multiple scrap areas and allows you to have different types and 

offsets of rubber for different size pieces of scrap. For example scrap of 1 inch or less can be one type of  

rubber, up to 2 inches another, up to 3 inches a third, and over that yet another type. To help speed this up, 

when adding pieces of scrap that are not closed shapes so on the very outside edge, the auto-copy function 

was changed to also work on these pieces, although will not copy rotated pieces in case you want the sides 

different from the lead / trail. 

 

 
 

This could result in something like the following. 

 



 
When adding ejection rubber windows with a trail offset, the tabs on the back side are now  

special cased, so there is some support against the rule on the trail edge. A small number of large 

tabs are used rather than multiple smaller ones on the regular offset sides. 

 

An improvement was made to the way rubber closes gaps. 

 

Some speed improvements were made to the layout arrange function. 

 

Designer Module 
 

Two additional folding carton filter standards were added. 

 

An additional corrugated display standard was added, another base. 

 

An additional onepiece corrugated standard was added. 

 

Miscellaneous 
 

Bobst ABC book specifications were updated for the newer specifications, so includes machines like the 

VISIONFOIL, EXPERTFOIL, the NOVACUTS, the EXPERTCUTS, and the MASTERCUTS. 

 

The Dieboard Edge Options Menu now also supports the plastic corner protectors that are more common 

in Europe. A standard and a secondary profile are both supported. 

 

The Bridge Utilities Menu now has an option to check the bridge depression lines in the design for 

overlaps. A clear pass or fail symbol is displayed on the design to confirm the status. 

 

Nicks was changed so that when copying / moving nicks, new selections are now possible. 

 

When adding side names, you can now change the setting right on the dialog for whether the individual 

letters are rotated or not, so can be changed on the fly rather than having to go to preferences. 

 

The standard laser driver now has the option to rotate 180 degrees as well as 90 degrees, and the same 

option was added to the Elcede drivers. The fixed clamps option was changed to also allow a 180 degree 

rotation to support this. 



 

The quick bridging and quick un-bridging now support undo. 

 

A parameter was added to allow what is in Info > Rule-lengths to be sent to Notepad instead of a simple 

dialog, so all the information can be printed easily. 

 

The creases in advanced ruletypes now support partial pointages like 1.4 / 1.5 / 1.6, so you can have non 

integer pointages to support the variety of crease profiles now available, and have that information show 

up in a DDES3 file. 

 

An additional thin-plate file was added to the counters thin-plate menu, the Bobst SPO160 Vision. 

 

When adding regular vector text, you can now also use the spacebar to rotate the name in 90 degree 

increments bypassing the longer question / method used to rotate the names. 

 



DOS / Windows 95 / Windows ME / Windows 98 / and 

Windows 2000 

 

Versions 16.x  / 14.x do NOT support Windows 2000, so require Windows XP at a minimum. 

 

When it comes to DOS, it is now well over 10 years since we went to a Windows platform. Apart from 

the fact that we basically can’t remember how to run the DOS version of CimCAD / CimPACK, almost 

none of the hardware in our office will even run the DOS version anymore. As such, we have no choice 

but to stop support for the DOS version, we are no longer capable of offering any effective support for it. 

We would encourage anyone still running DOS to take the plunge and upgrade their hardware and 

software. The activators for 16 are also incompatible with DOS, just another example of new hardware 

basically being Windows only. 

 

Thanks 

 

Windows XP 

 

Versions 16.0 basically still runs OK under Windows XP, granted some things are outside of our control. 

However, as you can imagine it has become increasing difficult to even maintain this level of 

functionality. Start making plans, as seems this will be the last version of CimPACK that runs on XP. 

 

 

Notice to CimCAD / CimPACK Customers Upgrading from a 

version earlier than Version 11.0 (such as. 10.4) 
 

Changes made to the Version 11.0 release shipped in July 2004 mean that if you have written any custom 

software, changes may be required. If that is the case and you need us to train you on the differences with 

11.0 please contact us for a quote on that.  

 

If you are upgrading from any 11.x version to 16.x there are no changes required, but if upgrading from 

Windows 10.4 to 15.x for example, then this applies to you. 

 

If you paid us to write custom software for you, it may need some work done on it to function correctly in 

the new version. 

 

Standard Laser Drivers and Router Maps supplied by Cimex will be converted free of charge, however 

means that we need a copy of your complete Local folder (including all sub-folders etc.) to convert, 

before we can ship your upgrade. 

 

If you have any question on this, please contact us.  

 

Thanks 

 

 



CimPACK Version 16.0 Windows Edition Upgrade Pricing 
 

 
 

From 

Windows 

Version 

Current 

V15.1 

Version 

15.0 

Any 

V14 

Any 

V13 

Any 

V12 

Any 

V11 

Any 

V10 

first user $900 $1200 $1600 $2000 $2250 $2500 $2750 

additional 

users 

$175 

per 

$200 

per 

$225 

per 

$250 

per 

$275 

per 

$300 

per 

$350 

per 
 

From 

DOS 

Versions 

Any 

Version 

first user $3000 

additional 

users 

$500 per 

 

 

To order the Windows upgrade, please fill out the attached order sheet and either mail or fax it to us.  

 

*** Version 16 only runs on a new type of USB key we have switched to, so anyone 

upgrading to 16 from any version of 11 or earlier needs new activators. Even if you 

currently have USB keys, we are now using a newer version of those USB keys, they 

look similar but are about ½ inch shorter than the original ones. Parallel keys have 

been phased out, as have activators that run DOS, these new keys will run Windows 

only. The older USB keys no longer used are the HASP4 keys, the newer ones for 12.1 

onwards are the HASP SRM keys. If unsure you can go to Help > About CimPACK, 

and next to the “Activator :” entry it says which type of USB key you are currently 

using.*** 

 

*** We can ship new replacement activators providing a purchase order is issued. The 

purchase order will cover the additional seats of software should the old activators not 

be returned within 30 days from the  update. (Subject to credit approval)  *** 

 

*** The activator registration forms must be filled in by the end user and faxed back 

before we can ship any software. The activator registration form provides the 

necessary information needed for us to program the activators with your license 

information.  *** 

 



 

  

 

CimPACK Version 16.0 Windows Edition Update Form 

 

 

 

 

 

 

 

 

 

 

 

 

 
 Current version of CimPACK ____________________ 
 

 Number of users  ____________________ 
 

 PO Number being used  ____________________ 

 (terms are net 30) 

 

We wish to purchase the following: 

CimPACK Version 16.0 Update   $______________ 
 

Replacement USB activators @ $70 each   $______________ 

 

Please check off the shipping method that you would prefer. 

UPS Ground _____________ 

UPS Blue 2 Day _____________ 

UPS Orange 3 Day _____________ 

UPS Red Next Day  _____________ 

 

 

Authorized Signature _______________________________  Date _________________________ 

 
 

Printed Name _____________________________________  Title _________________________ 

Cimex Corporation 

30 Business Technology Drive, Suite 2 

Belchertown, MA  01007 

Phone: 413-323-1090 

Fax: 413-323-1096 

www.cimexcorp.com 

 

Company Name _________________________________________________________________________________ 

 

Contact Person __________________________________________________________________________________ 

 

Address ________________________________________________________________________________________ 

 

________________________________________________________________________________________________ 

 

City / State / Zip ________________________________________________________________________________ 

 

Phone Number _________________________________________________________________________________ 

 

Fax Number ___________________________________________________________________________________ 

 

Email Address _________________________________________________________________________________ 


